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Figures are important

• Journal editors will read your 
cover letter and abstract then 
go over your figures

• “Figures are powerful tools to 
effectively and efficiently 
convey complex information” 
Rolandi, Cheng, & Perez-Kriz, 2011

• Good figures are:
• Clear

• Precise 

• Efficient 



Software for producing graphs (and more)

• Programming based
• Python (free)

• MatPlotLib

• SeaBorn

Python SeaBorn example



t = [time];

s = [signal]; # voltage

f = 5000; # sampling freq

plt.subplot(211)

plt.plot(t, s)

plt.subplot(212)

plt.psd(s, 512, 1 / f)

Quick Python Plotting – with MatPlotLib



Software for producing graphs (and more)

• Programming based
• Python (free)

• MatPlotLib

• SeaBorn

• R (free)

• Matlab ($, but covered)

• Web-based
• Plots of Data by UVA (free)

Python SeaBorn example

https://huygens.science.uva.nl/PlotsOfData/


PlotsOfData - Plots all Of the Data

• https://huygens.science.uva.n
l/PlotsOfData/

• Upload you data
• copy+paste

• .csv (Excel)

• Plot the data

• Data summaries

https://journals.plos.org/plosbiology/article?id=10.1371%2Fjournal.pbio.3000202

https://huygens.science.uva.nl/PlotsOfData/


Software for producing graphs (and more)

• Programming based
• Python (free)

• MatPlotLib
• SeaBorn

• R (free)
• Matlab ($, but covered)

• Web-based
• Plots of Data by UVA (free)

• Out-of-the-box
• GraphPad ($, but covered)
• SPSS ($, but covered)
• Excel (~)
• ImageJ (free)
• Origin ($)
• SigmaPlot ($)

Python SeaBorn example

https://huygens.science.uva.nl/PlotsOfData/


Software for putting together figures

• Inkscape (free)

• GIMP (free)
• Image focused

• Adobe Illustrator ($, varies)

• PowerPoint (~)

• Blender (free)
• Specializes in 3D

Porter, Hillman, Bilkey, 2019



Options for making diagrams

• DIY 
• Inkscape, Illustrator, PowerPoint

• BioRender (~)
• $ use in journals

• $15 per month students

• ScienceDraw by Edraw ($)

BioRender Example



Licensing of images

• Most journals constitute 
commercial use

• Wiki-commons

• CreativeCommons –
ShareAlike

• “Free-use”





Bur first, Tables
• Individual data points matter

• Compare individual points 

• Precision is needed

• Quantitative information 

• Multiple units of measure 

• A mix of summary and 
detailed values

Show Me the Numbers: Designing Tables and Graphs to Enlighten – Second Edition

http://www.amazon.com/Show-Me-Numbers-Designing-Enlighten/dp/0970601972


Back to graphs

• Show the data

• Induce the viewer to think about 
the substance of the findings

• Avoid distorting the data 

• Make large data sets coherent

• Encourage the eye to compare 
different pieces of data

• Reveal the data at several levels 
of detail, from a broad overview to 
the fine structure

• Integrated with the statistical and 
verbal descriptions of the data set

From E. R. Tufte. The Visual Display of Quantitative Information, 2nd Edition. Graphics Press, Cheshire, Connecticut, 

2001 in http://sphweb.bumc.bu.edu/otlt/MPH-Modules/BS/DataPresentation/DataPresentation3.html 



Pie Charts

• Generally frowned upon

• Have their use
• When proportion is important

• When 100% is meaningful

• Few, <= 4, nominal categories 

• Alternatives
• Line/bar chart

• Humans are very good at line 
length discrimination

• Area of pie slices not so much

• NO 3D! 



Generic Excel Pie Charts

Stacked bar chart (ordinal)

http://www.storytellingwithdata.com/blog

/2014/06/alternatives-to-pies

Pie Chart: *exists*

Data viz nerds:



Bar or line?

http://sphweb.bumc.bu.edu/otlt/MPH-

Modules/BS/DataPresentation/DataPresentation7.html



Or nothing

Of the 150 neurons we recorded, 70 (47%) were excitatory while 80 (53%) were inhibitory.



Histograms

• Shows the distribution of a 
data set

• Bin width is a hard problem
• 8+ formulas

• √# of data points (Excel)

• No spaces between bars

https://plot.ly/matlab/histograms/ https://towardsdatascience.com/histograms-and-density-plots-in-python-f6bda88f5ac0

Python



Histograms

• Shows the distribution of a 
data set

• Bin width is a hard problem
• 8+ formulas

• √# of data points (Excel)

• No spaces between bars

• Be careful with multiple 
variables

• KDE may be better choice

https://plot.ly/matlab/histograms/ https://towardsdatascience.com/histograms-and-density-plots-in-python-f6bda88f5ac0

Python



Histograms

• Shows the distribution of a 
data set

• Bin width is a hard problem
• 8+ formulas

• √# of data points (Excel)

• No spaces between bars

• Be careful with multiple 
variables

• KDE may be better choice

https://plot.ly/matlab/histograms/ https://towardsdatascience.com/histograms-and-density-plots-in-python-f6bda88f5ac0

Python



Let’s end the bar graph

Beyond Bar and Line 
Graphs: Time for a New Data 
Presentation Paradigm –
PLoS Biology

• Show the dots in the plots –
Nature

• Leaving the bar in five steps 
– The Node

• Data visualization, bar naked 
– Journal of Biological 
Chemistry

https://journals.plos.org/plosbiology/article?id=10.1371/journal.pbio.1002128
https://www.nature.com/articles/s41551-017-0079
http://thenode.biologists.com/leaving-bar-five-steps/research/
http://www.jbc.org/content/292/50/20592.full.pdf


Unpaired data

Weissgerber et al, 2015



Paired data

Weissgerber et al, 2015



Bar graphs do have their uses

• When you have an independent, 
qualitative variable with nominal 
categories

• Discrete data: Dependent 
variable is a count or frequency 

• Normal distributions

• Misrepresenting your data

• Propaganda

• Destroying a country because 
Russia told you to

• But see Mueller, 2019, I guess

Beniger & Robyn, 1978



Bar alternatives – Box and Whisker

Beebe et al., 2016 – Using R

 Excel



Outlier

https://en.wikipedia.org/wiki/Box_plot



Bonus points for showing data points*
aka pirate plot in R

*When applicable

Made in R https://www.reddit.com/r/rstats/comments/7z1yvg/how_can_i_recreate_this_half_boxwhisker_and_half/



Bar alternatives – Dot plot/scatter*

http://thenode.biologists.com/leaving-bar-five-steps/research/

*Not X/Y scatter plot

Made in R with ggplot2 and boxplotR – now PlotsOfData

Bar graph: *Exists*

Joachim Goedhart:

@joachimGoedhart

https://twitter.com/joachimgoedhart


Bar alternatives – Dot plot/scatter*

http://thenode.biologists.com/leaving-bar-five-steps/research/

*Not X/Y scatter plot

Made in R with ggplot2 and boxplotR – now PlotsOfData

@joachimGoedhart

https://twitter.com/joachimgoedhart


Bar alternative – Violin plots

https://www.graphpad.com/guides/prism/8/user-guide/graphing-box-and-whisker-and-v.htm



Python with Seaborn

ax = sns.violinplot(x="day", y="total_bill", data=tips)

https://seaborn.pydata.org/generated/seaborn.violinplot.html



ALL THE THINGS
Raincloud plots

Made with Matlab with Raincloud by Allen et al., 2018

Available for Matlab, R, and Python Giulio, Bush, and Jeffery, 2019

https://peerj.com/preprints/27137/


Back to graphs

• Show the data

• Induce the viewer to think about 
the substance of the findings

• Avoid distorting what the data 

• Make large data sets coherent

• Encourage the eye to compare 
different pieces of data

• Reveal the data at several levels 
of detail, from a broad overview to 
the fine structure

• Integrated with the statistical and 
verbal descriptions of the data set

From E. R. Tufte. The Visual Display of Quantitative Information, 2nd Edition. Graphics Press, Cheshire, Connecticut, 

2001 in http://sphweb.bumc.bu.edu/otlt/MPH-Modules/BS/DataPresentation/DataPresentation3.html 



Scatter plots – x/y

• How one variable changes 
due to a second variable

• If time is a variable, it should 
be on the X axis

• Make sure your trend line 
stands out

http://biostat.mc.vanderbilt.edu/wiki/pub/Main/StatGraphCourse/graphscourse.pdfMade in R



Line graphs

Matlab

Dykes, Porter, & Colombo, 2018Matlab - Prsa et al., 2019



Whatever you pick, error bars are necessary

Matlab



Whatever you pick, error bars are necessary

• Standard deviation (SD)
• Better for comparing individual 

samples to the population 

• Not used when comparing 
multiple groups

• Normal distribution

Matlab



Whatever you pick, error bars are necessary

• Standard error of the mean 
(SEM)

• Comparing observations and 
the accuracy of a mean

• Normal distribution

Matlab



Whatever you pick, error bars are necessary

• Confidence intervals (CI)
• Fewer assumptions*

• More complicated to derive*

• Visually show significant 
differences

Matlab



Do NOT use Excel’s built in error bars



Do NOT use Excel’s built in error bars
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Ugly excel graph but at least it has 
real error bars



Showing Significance

Python with MatPlotLib and SeaBorn



Showing Significance

Python with MatPlotLib and SeaBorn



Showing Significance

Python with MatPlotLib and SeaBorn

Crowding solutions



Showing Significance

Python with MatPlotLib and SeaBorn

Using letters
Shared letter = not different

Different letter = sig diff



Showing Significance

Python with MatPlotLib and SeaBorn

Beebe et al., 2016 – Using R

Just lines



Showing Significance

Hillman & Bilkey, 2010

Show the table
Doesn’t show pairwise



Using color effectively 

• “… avoiding catastrophe 
becomes the first principle in 
bringing color to information: 
Above all, do no harm. “ – Tufte, 
1990

• Stick to greyscale when possible

• Ensure the use of color adds 
value to the reader

• Can be distracting at best and 
confusing at worst

• Color costs $$$$



Color –Sequential data

• Variables: Ordinal
• e.g. dose response 

• Data: Using a minimum 
baseline

• Lighter = less/min/zero

• Darker = more/max 

https://betterfigures.org/2015/06/23/picking-a-colour-scale-for-scientific-graphics/



Color – Diverging data

• Variables: Ordinal 
• e.g. Likert scale

• Data: centers around some 
value (0, mean/median)

• Shown as white

• e.g. Z-scores

• Contrasting colors

Porter, Hillman, & Bilkey, 2019



Color – Qualitative data

• Variables: Nominal

• Keep brightness the same
• Unless using paired data



Beautiful palettes from ColorBrewer2.org



Color as a 3rd dimension

• Great way to plot another 
dimension of data

• Color choice is very important
• As numerical values will not be 

directly seen

Rangel et al., 2015



NO RAINBOWS

https://mycarta.wordpress.com/2013/02/21/perceptual-rainbow-palette-the-method/ https://eagereyes.org/basics/rainbow-color-map



Many alternatives (with cooler names) 

https://matplotlib.org/users/colormaps.htmlMatlab’s “Parula”



Y zero?

• Starting at zero is generally a 
good idea

• When zero is a possible data 
point

• Using bar charts

• If not using zero
• Start y-axis at your minimum 

data point

• A statistically reasonable range 
• ± 3 SD

• Data points are shown

• Data should fill the space

Duquia et al., 2014



Logarithmic scales

• Percent change
• Weber-Fechner law

• Multiplicative factors
• Dendrite spin size

• Numerosity encoding

• Skewed data
• Neuron firing rates

• 1/f power rule for EEG/LFP

https://matplotlib.org/examples/scales/scales.html



Tick marks and guidelines

• Careful not to overcrowd 
• You don’t need to label every 

tick

• Use guidelines to subtly draw 
attention

• Make sure they don’t distract 
from data (esp line graphs, 
trend)

• Err on less, or none

Statistics New Zealand Graphics Guidelines



Using text effectively

• Font size should go from 

larger to smaller as you go 
outside in

• Make sure values aren’t too 
small

• Make fewer ticks for larger 
fonts

R - http://www.sthda.com/english/wiki/print.php?id=145



Questions?

https://xkcd.com/1945/ https://xkcd.com/1967/



Inkscape
Vector graphics editor

https://inkscape.org/



This PowerPoint on Inkscape was 
created by Aiora Zabala, Simon 

Andrews, and Boo Virk 
https://bioinformatics-core-shared-training.github.io/

https://slideplayer.com/slide/3838119/

Aiora Zabala http://aiorazabala.net/

Simon Andrews http://proteo.me.uk/about/

Boo Virk @bv208

https://bioinformatics-core-shared-training.github.io/
https://slideplayer.com/slide/3838119/
http://aiorazabala.net/
http://proteo.me.uk/about/
https://twitter.com/bv208


What is Inkscape?

• Vector graphics editor

• Free, open source

• Cross platform

• Easy-ish to use

• Good for:

• Composing figures

• Drawing

• Weak:

• Editing images



Images are made by points and their connections. 

Connections can be straight or smooth

Images are madeof 

pixels and acolor 

value

Bitmaps Vector Graphics



Vector graphics

• No resolution

• Fully editable



Scaling figures

• Vector images can be scaled freely without lossof  quality

• Bitmap images can be scaled down, but not up

Vector Bitmap



• File > Document  

Properties

– Shows page in view

– Doesn’t restrict  

drawing

– Useful asa guide

• Change background  

color to white

• Change to landscape

Exercise 1: Setup a Canvas



Moving around

●

●

●

Panning

– Scroll bars on bottom / right

– Scroll up/down, Shift+scroll for left/right

Zooming in / out

– Click to zoom in, shift+click to zoom out

– Control + Scroll Up/Down to zoom in/out to cursor

Shortcuts

– Fit page, drawing, selection in window



• Selection tool, F1  

• Edit nodes tool, F2

• Sculpt tool

• Zoom tool, F3 

• Measurement tool

• Make rectangles, F4

• Make 3D boxes

• Make ellipses / arcs, F5  

• Make polygons / stars

• Make spirals, F9

The main toolbar

• Draw freehand lines, F6  

• Draw straight lines / curves  

• Calligraphy tool

• Add text, F8  

• Sculpt with spray

• Erase

• Fill

• Edit gradients  

• Select color

• Create diagram connectors



Create basic shapes

• Select a tool from toolbar

• Click and drag oncanvas

– Box selects the bounds of the newshape

– Colors are remembered from the lastshape

• Basic options appear in toptoolbar

– Number of spokes on stars

– Rounded corners on rectangles

– Circle vs segment vs arc



Control nodes

• Use the Edit Nodes tool

• Two types of control points, squares andcircles

– Squares generally change the size of the shape

– Circles change the appearance



General transformations

• Select the Selection tool

• Moving – Click and drag anobject

• Duplicating – Select object and pressCtrl+D

• Resizing /Rotating

– Click on object

– Click again to change control arrow type

– Click and drag arrows to resize / rotate



Resize / Rotate

• Can use shift/control keyboard modifiers asbefore

• For rotation you can move the crosshair tochange  

the center of rotation

resize rotate



Transform Shortcuts

• Rotate 90 degrees anticlockwise

• Rotate 90 degrees clockwise

• Mirror object around the verticalaxis

• Mirror object around the horizontalaxis



Selecting

• Selecting multiple objects,either:

– Drag a box to cover multiple objects

– Shift+click:

● to add an object to a selection

● on a selected object to remove it from the selection



Grouping

• Grouping (right click > Group or Ctrl +G)

– Combine multiple objects into a singleobject

– Reversible: Ungroup (Control+Shift+G)



Aligning and distributing
• Object > Align and Distribute

– Align = Give objects the same  

center/edge position

– Distribute = Space objects  

evenly

• Align relative to

– First/Last selected object in  

group

– Largest/Smallest object in  

group

– Page

– Drawing

• Never align anything byeye!



Fill and Stroke (Outline)
• Fill = Color/ Gradient/  

Pattern within ashape

• Stroke = The line around  

a shape

• Object > Fill and Stroke  

(Shift+Ctrl+F)

• Edit

– Colors

– Opacity

– Blur



Fill and Stoke

• Fill types

– Flat color

– Linear gradient

– Circular gradient

– Specify color and 

alpha(opacity)



Stroke Options

• Width of line

• Shape of corners

• Shape of line ends

• Dashes

• Markers/Arrowheads



Create this 2x4 grid:

Draw a rectangle with curved corners, duplicate  it 

as necessary, align the figures

Exercise 2: Create and align shapes



Tools/ attributes to do this: rectangle, corner radius, fill  and 

stroke, select (and groupif necessary) and alignment

Exercise 2: Create and align shapes



Creating and Editing Paths

• Created using freehand or line tool

• Can convert other objects to become a path

• Paths are composed of nodes and segments

• There are different types of node and  

segment



Nodes and Segments

• Segment types

– Lines (1)

– Curves (2)

• Node types

– End (3)

– Corner (4)

– Smooth (5)

• Normal

• Symmetric

• Auto

1

22

2

3 3

4

5



Editing nodes

• Use nodes toolbar to add, remove or convert  

nodes or segments

• Select nodes or segments to make their  

handles visible

• Drag handles to change the arc of curves



Exercise 3: Drawing an action 
potential

• Use the Bezier tool

• Plot out an AP

• Use the Edit nodes tool

• Smooth your AP 
• So it doesn’t look like electrical noise

Or Picasso AP?



Combining paths

• You may want to add or subtract objects from 

each other

• Use Paths (Path > Object to Path)

• Lots of options for joining paths together



• Create two overlapping 

shapes

• Change their fills

• Copy & paste them six 

times

• Apply path  combinations 

to each pair of shapes

Exercise 4: path combinations

Union Difference Intersection

Exclusion Division Cut Path



Opacity / Blur

• Applies to whole object

• Separate from alpha in colors

• Works on all Objects



Opacity / Blur

• Applies to whole object

• Separate from alpha in colors

• Works on all Objects



Gradients
• Standard color option

• Set multiple colors / opacities to go through

• Set the direction and extent of thegradient



Ordering / Forward-Backward

• New objects sit over the top of old objects

• Objects obscure those underneath them (exceptfor  

transparency)



Z-axis ordering / stacking / layers

• Send object to bottom ofz-stack

• Lower object one level

• Raise object one level

• Bring object to top



Working with bitmaps(images/photos)

• Inkscapecan include bitmaps in images

• Appear as objects alongside vector objects

• Can’t edit the images

• Can’t increase the resolution of theimage

• Transparency (eg PNG) ispreserved

• File > Import

• Formats: PNG, JPEG, SVG, PDFetc.



• Use the text tool toadd text.

• Click and type to generatetext

• Text can be scaled or rotated as any other object

– Always hold Ctrl when scaling otherwise the aspect

ratio  will be messedup

Exercise 5: Add text



Text options

Text toolbar

space letters

space words

x pos

y pos

rotate



Making figures



File formats

• Vectors: for anything that has been 

generated by a computer: graphs,  

illustrations, and text.

• File types:

• .svg

• .eps

• .pdf

• .ai

• Bitmaps: for figure components 

generated by a camera (e.g. 

microscopy or blot photos).

• File types:

• .png

• .jpg/jpeg

• .gif

• .bmp

• .tif/.tiff



File formats

• Bitmap images can be embedded within a vector image

• Ideally, publication figures should be vector graphics for 

assembly and annotation of figure panels, with bitmap images 

embedded within

• This ensures that no resolution will be lost, no weird blurring, 
text shifting, weird overlapping

• Though not all journals accept vector formats 



Export from Excel

• Select your graph

• File > Save as… > Select PDF



Export from Python with MatPlotLib

# code for plot

plt.savefig(‘awesomeData.svg‘)

• Supports all the file types

• Many options for saving

• size, resolution, page size, background color/transparent 



Export from R
In PDF:

pdf(file="myplot.pdf")

# … code of plot here  

dev.off()

Other formats:

• png()

• jpeg()

• bmp()

• tiff()

• svg()

• postscript()

They all have arguments to set dimensions, resolution, etc. although the syntax can vary slightly.



Export from GraphPad



Export from SPSS



Exporting files from Inkscape: Vector

• Some journals accept PDF 
figures 
• Inkscape makes sizing your 

figures easy

• Many other vector file types
• .svg, .eps, .emf, .tex

• File > Save (As), select  
PDF



Exporting files from Inkscape: Bitmap

• If journals make you
• If you have very complex 

figures with many points/dots
• Bitmaps smaller in size, faster to 

load

• File > Export PNG Image

• PNG only
• https://convertio.co/png-tiff/

• https://www.irfanview.com/

https://convertio.co/png-tiff/
https://www.irfanview.com/


Saving vs Exporting

• In Inkscape (and any other vector software) distinguish between 

working or editable files (e.g.  SVG), which are best seen with the 

software that  created them, and files for sharing or publication  

(e.g. PDF or TIFF), which do not keep full editing features

• Save the file frequently while working on it

• Export the file once it’s ready to share



Basic Steps in Preparation

• Determine the final size of the figure (journal guidelines)

• Heights of text, thickness of lines

• Figure in color, grayscale or black and white (journal guidelines)

• Resolution (journal guidelines)

• Acceptable File format: choose the best one, vector if possible

• Colorspace: CMYK or RGB (journal guidelines)



Questions?

Twitter: @Obhrc or @BlakeP_Neuro

Email: blakeporterneuro@gmail.com

Website: www.blakeporterneuro.com

https://twitter.com/OBhrc
twitter.com/BlakeP_Neuro
https://www.blakeporterneuro.com/


Python resources 

Learning Python
• learnPython.org – Basics

Python by DataCamp – Interactive 
learning (4 free courses)

• Python2 by CodeAcademy –
Interactive learning (mix free and $)

• Python for Neuroscience – Workshop 
from University of Chicago

• Some experience assumed

• www.blakeporterneuro.com

Python tools

• Spyder Environment for 
Python – makes work easier

• Matplotlib – for making 
graphs

• Seaborn – for nice graphs

https://www.learnpython.org/
https://www.datacamp.com/courses/intro-to-python-for-data-science
https://www.codecademy.com/learn/learn-python
https://github.com/kylerbrown/python-for-neuroscience
https://www.blakeporterneuro.com/category/computer-science/learning-python/
https://www.spyder-ide.org/
https://matplotlib.org/
https://seaborn.pydata.org/


Inkscape resources 

• Inkscape – website for download and learning

• Designing effective scientific figures Introduction to Inkscape to 
finalise figures

• Youtube
• Eg https://youtu.be/zUIOEXssTSE

• https://bioinformatics-core-shared-training.github.io/effective-
figure-
design/DesigningEffectiveScientificFigures_Practical_INKSCAP
E_Zabala_v00.pdf

• https://slideplayer.com/slide/3838119/

https://inkscape.org/
https://inkscape.org/release/inkscape-0.92.4/
https://inkscape.org/learn/tutorials/
https://bioinformatics-core-shared-training.github.io/effective-figure-design/DesigningEffectiveScientificFigures_Practical_INKSCAPE_Zabala_v00.pdf
https://youtu.be/zUIOEXssTSE
https://bioinformatics-core-shared-training.github.io/effective-figure-design/DesigningEffectiveScientificFigures_Practical_INKSCAPE_Zabala_v00.pdf
https://slideplayer.com/slide/3838119/


A literal (up-to-date) book on graph making

• http://biostat.mc.vanderbilt.edu/wiki/pub/Main/StatGraphCourse
/graphscourse.pdf

http://biostat.mc.vanderbilt.edu/wiki/pub/Main/StatGraphCourse/graphscourse.pdf


General figure making guides

• How to Create Publication-Quality Figures

• Ten Simple Rules for Better Figures

• A brief guide to designing effective figures for the scientific 
paper

• Designing science graphs for data analysis and presentation

• What graph do i pick?

• Presenting data in tables and charts

•

http://cellbio.emory.edu/bnanes/figures/
https://journals.plos.org/ploscompbiol/article?id=10.1371/journal.pcbi.1003833
https://faculty.uca.edu/patrickd/Chem4112/Effective_Figures.pdf
https://www.doc.govt.nz/Documents/science-and-technical/docts32entire.pdf
http://www.perceptualedge.com/images/Effective_Chart_Design.pdf
https://www.researchgate.net/publication/261921512_Presenting_data_in_tables_and_charts


Data visualization

• http://www.storytellingwithdata.com/

• https://www.tableau.com/learn/articles/best-data-visualization-
blogs

• https://www.tableau.com/learn/articles/data-science-blogs

• https://guides.library.duke.edu/datavis/topten

• http://thenode.biologists.com/author/joachimg/

http://www.storytellingwithdata.com/
https://www.tableau.com/learn/articles/best-data-visualization-blogs
https://www.tableau.com/learn/articles/data-science-blogs
https://guides.library.duke.edu/datavis/topten
http://thenode.biologists.com/author/joachimg/


Color

• http://seaborn.pydata.org/tutorial/color_palettes.html

• https://matplotlib.org/users/colormaps.html

• https://betterfigures.org/2015/06/23/picking-a-colour-scale-for-
scientific-graphics/

• http://colorbrewer2.org

http://seaborn.pydata.org/tutorial/color_palettes.html
https://matplotlib.org/users/colormaps.html
https://betterfigures.org/2015/06/23/picking-a-colour-scale-for-scientific-graphics/
http://colorbrewer2.org/


Resources I used/read to make this 
presentation in no order whatsoever

• https://www.prismnet.com/~hcexres/textbook/tables.html

• https://matplotlib.org/gallery/index.html

• https://hackerspace.kinja.com/5-rules-for-making-graphs-1605706367

• https://www3.nd.edu/~pkamat/pdf/graphs.pdf

• http://personal.psu.edu/dys100/GraphingBackgroundRules.pdf

• http://berkeleysciencereview.com/errorbars-anyway/

• https://www.biologyforlife.com/interpreting-error-bars.html

• https://www.biologyforlife.com/graphing-with-excel.html

• http://sphweb.bumc.bu.edu/otlt/MPH-Modules/BS/DataPresentation.html

• https://blog.datawrapper.de/pie-charts/

• https://depictdatastudio.com/when-pie-charts-are-okay-seriously-guidelines-for-
using-pie-and-donut-charts/

https://www.prismnet.com/~hcexres/textbook/tables.html
https://matplotlib.org/gallery/index.html
https://hackerspace.kinja.com/5-rules-for-making-graphs-1605706367
https://www3.nd.edu/~pkamat/pdf/graphs.pdf
http://personal.psu.edu/dys100/GraphingBackgroundRules.pdf
http://berkeleysciencereview.com/errorbars-anyway/
https://www.biologyforlife.com/interpreting-error-bars.html
https://www.biologyforlife.com/graphing-with-excel.html
http://sphweb.bumc.bu.edu/otlt/MPH-Modules/BS/DataPresentation.html
https://blog.datawrapper.de/pie-charts/
https://depictdatastudio.com/when-pie-charts-are-okay-seriously-guidelines-for-using-pie-and-donut-charts/


Resources I used/read to make this 
presentation in no order whatsoever

• https://www.biologyforlife.com/interpreting-error-bars.html

• http://berkeleysciencereview.com/errorbars-anyway/

• https://www.cruk.cam.ac.uk/core-facilities/bioinformatics-
core/training

• https://bioinformatics-core-shared-training.github.io/effective-
figure-
design/DesigningEffectiveScientificFigures_Zabala_morning_v0
0.pdf

https://www.biologyforlife.com/interpreting-error-bars.html
http://berkeleysciencereview.com/errorbars-anyway/
https://www.cruk.cam.ac.uk/core-facilities/bioinformatics-core/training
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